
Ransomware Is Going After Your Remote 
Workforce 

“I had to take a moment to give extra special thanks to Josh. He has been at our site several times for our 
onboarding and has also worked with a number of my staff via phone support. I was initially nervous about 

moving over to the new support system as my staff had become accustomed to someone being in the office 
most of the time. This transition could not have gone smoother and I have received nothing but good feedback 
from my staff about our IT Support. Many of them specifically have a fondness for Josh and the help he has 
given us since we started. He is exceptionally smart and has developed a great rapport with myself and every 

member of my staff that has had the pleasure of working with him. I want to formally express our appreciation 
and gratitude for his time, expertise, and demeanor. He is an absolute pleasure to work with!”        
                  
Nicole Plath  

Chief Executive Officer 
Fortune Title Agency 
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What our clients are saying:  
Fortune Title Agency 

Following predictions made in 2019, ransomware has surged in 2020; however, the mass shift to a largely 
remote workforce has amplified existing trends. Observers have noted a sharp increase in hackers targeting 
employees working from home as they leverage the unfamiliarity of many with telecommuting 
cybersecurity. With a widespread lack of proper security training and education among many that are 
remotely accessing desktops, cybercriminals see an unprecedented opportunity to collect ransoms. 
 
Learn more about how ransomware is affecting the remote workforce during the pandemic, and how you 
can protect against it: 
 

Phishing Surges During COVID-19 - What You Need to Know 
One of the top cybersecurity lessons learned during COVID-19 is that phishing is the go-to tactic for 
hackers going after individual employees, though each has a preferred delivery method. However, the end 
objective still remains the same, as does the thinking behind each technique. The shift to working from 
home has only exacerbated the factors that make malware infection through spoofing such an effective 
cyber attack. 
 
The growth of ransomware was a natural evolution of this cybercriminal culture as it allows for a much 
quicker, easier and more emotionally-driven payday from successfully breaching a network. Instead of 
shopping for clients hackers can just sell your data right back to you as a captive market, and if you do not 
want to pay then they can steal it and use it to threaten your reputation (or compliance). Remote workers 
can often be perfect phishing targets, as many will be ignoring strict cybersecurity practices between the 
distractions at work and home, and out of the watchful eye of underequipped IT departments. 
 

The Russians are Coming - Gangs Target Telecommuters 
Ransomware gangs can come from anywhere, but many of the most prolific are from North Korea and 
Russia. One of the latter, a notorious group calling themselves “Evil Corp” that may be tied to the Russian 
government, has already been caught targeting at least 31 organizations in the US through their remote 
workers. Despite already being under the scrutiny of American authorities, they managed to infect and 
collect $10 million in ransom from GPS giant Garmin - all because an employee fell for a phishing email. 
 
There have been quite a few high-profile data breaches that were tied to surges in ransomware gang 
activity like with Evil Corp. and their contemporaries. It is likely that their committed campaign reflected a 
general understanding among hackers of the increased cybercrime opportunities during the coronavirus 
pandemic. 
 
Continued on page 2... 
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Are You STILL Using Outdated 
Tape Backups? 

   If your computer network and the data it 
holds got erased or corrupted because of a 
virus, hard drive crash, fire, flood or some 
other random, unforeseen disaster, how 
confident are you RIGHT NOW that 
your business could be back up and 
running again FAST? 

 
   If your answer to that is, “I don’t know,” 
or “I’m not sure,” you are taking a HUGE 
risk with your company’s most important 
asset—the data on your network. Just 
imagine what would happen to your 
business if you lost your entire client 
database… 

 
…Lost all accounting documentation and 
history…Lost all the work files you’ve 
spent YEARS developing…Lost the work 
files and documentation you so desperately 
need to service your customers… 

 
   Can you even put a price tag on it? 
Probably not –yet so many business 
owners aren’t 100% certain that they could 
be back up and running after a disaster and 
are purely hoping that their current tape 
drive or backup is working and storing a 
usable copy of their data. 

 

Tape Drives Are The MOST 
Unreliable, Unsecured Way To 

Back Up Your Data 
 
   All tape drives fail; it’s only a matter of 
“when,” not “if.” So if being able to get 
back up and running again in the event of 
a data-erasing disaster is important, then 
you need to know about our <<Name Of 
Backup>>.  
 
   <<Outline the benefits here: This fool-
proof backup service does more than just 
keep a copy of your files—it provides 
“continuous data protection” and enables 
near-instant disaster recovery because it 
takes a snapshot of your entire network 
throughout the day, giving you the 
confidence we could have you back up and 
running again within HOURS, not days or 
weeks.>>  
 
   Want to know if your data is 
REALLY secure and being backed up 
properly? Call us for a FREE Data 
Backup and Disaster Recovery Audit Call 
us at xxx-xxx-xxxx or go online to 
www.insertyoururl.com/backup 

Two ways to 
WIN a gift 

card! 
It only takes a minute and YOU 

could be our next winner! 

Last Month’s  
Contest Winner: 

Cindy Daley 
Friendly Planet Travel 

 
Please complete our brief survey in 
order to be placed in the running to 
win this month's gift card prize!  
 
1. What do you like most about 
our services? 

2. Tell us about a specific 
experience with us that you were 
happy with. 

3. What are the biggest benefits 
you’ve received or experienced 
since hiring us? 
 

4. What can we improve? 
 
Email Jon Stiles 
(jonathan.stiles@swktech.com) with 
your responses  
OR  
Fill out our online form: 
http://bit.ly/nwsnews-survey 
before Oct 5th to get your name in 
the hat.  
 

You could win a 
$25 Gift Card! 

Get More Free Tips, Tools, and Services on Our Website: www.swknetworkservices.com 

 

Your Microsoft Outlook application provides a host of features that enable you to optimize your schedule planning 
and boost productivity. Updates are regularly released for the Office 365 suite that improve the communication 
capabilities, cybersecurity, time management and integration between your various apps. SWK Technologies can 
help you navigate through the assortment of tools if you ever feel overwhelmed and have a hard time keeping track 
of every your email app has to offer. 
 
SWK provides proactive news, updates, and support for all of your Windows implementations, and will help you 
capture the most value from Office 365.  
 
1. Organize Your Outlook Inbox 
Is your Outlook inbox getting a little too cluttered for your liking? Use the Clean Up feature to tidy up your inbox. 
From your inbox, click the Home tab and choose from one of three Clean Up options: 

• Clean Up Conversation – reviews an email thread or a conversation and deletes redundant messages 

• Clean Up Folder – reviews conversations in a selected folder and deletes redundant messages 

• Clean Up Folder & Subfolders – reviews all messages in a selected folder and any subfolders, and deletes 
redundant messages in all of them 
 
2. Click Ignore Conversations 
Besides redundant messages, group conversations that aren’t relevant to you can clutter up your inbox. The Ignore 
button helps you organize your inbox and focus on relevant emails. 
 
To activate this feature, select a message, then click Home > Ignore > Ignore Conversation. You can also do this 
by opening a message in a new window and clicking Ignore under the Delete function. You can easily revert this 
action by going to the Deleted Items folder and clicking Ignore > Stop Ignoring Conversation. 
 
Continued on page 3... 

5 Tips for Working Smarter in Microsoft Outlook 

Continued from page 1... 

 

Top Ransomware Used for Remote Workers 
Though too often a successful malware infection will go unnoticed, researchers 
have been able to document the types of ransomware that are seen most often in 
2020. Many collectives have displayed a pattern of shifting between different 
toolkits for each campaign, however, there are a few repeat offenders that were 
likely shopped around and bought on the Dark Web. Here are the top file types 
that have been witnessed the most so far: 

• Maze 

• REvil 

• Ryuk 

• Tycoon 

• NetWalker 

• WastedLocker 

• Dharma  

• DoppelPaymer 
 
It is important to note that there are many more file types out there that have yet to be uncovered, and even many of 
those that have been are only verified through their copious usage. While some “families” of ransomware are often 
associated with a specific gang (often its creator), through darknet exchanges - and theft - the toolkits are proliferated 
among hackers of a wide range of skill. Sophisticated hackers are a real danger, but even amateurs can get lucky if 
they come across a weakly defended endpoint, and have the time and persistence to exploit it. 
 

Cybercriminals Exploiting Employees Working from Home 
There are many benefits to a distributed workforce despite the cyber risk, however, the problem is that cybersecurity 
should be the number one concern for telecommuting employees. Bad security practice was unfortunately a common 
enough trend before COVID-19 - this pattern crossed over into the new normal and amplified existing vulnerabilities. 
Your business must adjust its understanding of IT for a working from home environment to limit your attack surface 
and mitigate the threat of ransomware.  
 
Remotely accessing business data needs to be done across secure channels and with extra layers of cybersecurity to 
distinguish real users from intruders. Hackers are exploiting bugs and gaps that were already present before the 
pandemic, but are even more exposed for employees working from home with less oversight.  
 

Protect Your Remote Workforce from Ransomware 
The ransomware surge is part of a greater cybersecurity crisis that was expanded by the new normal, but has been 
affecting SMBs for quite some time. Cyber threats from within and without are exposing smaller and mid-sized 
business to increased malware risks - discover how to identify and combat them with help from SWK. 
 
Download our guide on The Cybersecurity Crisis and learn how to protect your remote workforce from ransomware 
and other cyber threats. 

Ransomware Is Going After Your Remote 
Workforce 
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Gift Card Trivia! 

This month’s question is: 
 

What is a benefit of cloud hosting? ( Hint: The answer is in this newsletter.) 

 
a. Save on infrastructure costs 
b. Remote access for employees 
c. Backup and protection of data 
d. All of the above 

 
Please email Jon Stiles (jonathan.stiles@swktech.com) with your answer by Oct 5th, in order to be placed in 
the running for this month's gift card prize!  

Continued from page 2… 

 

Windows 10 Keyboard Shortcuts 
Discover more shortcuts you can use to save time in Windows 10 
with quick keyboard commands: 
10 Keyboard Shortcuts for Windows 10 
 

3. Send Links to OneDrive Files 
This function is especially useful when you need to send large files 
to your coworkers or clients. You can send a link to the file instead 
of the file itself as well as set permissions to allow recipients to 
edit and collaborate on linked files in real time. 
 
To do this, upload the file you wish to send to OneDrive. Then 
from the message box, click Attach File > Browse web locations > 
OneDrive. 
 

OneDrive VS SharePoint 
Discover some extra tips on leveraging the cloud storage options in Office 365: 
Choosing Storage: OneDrive VS SharePoint 
 

4. Schedule a Microsoft Teams Meeting 
Microsoft Teams is unified communication and collaboration platform that also includes an Outlook add-in. 
This feature allows you to set up Teams meetings directly from Outlook. It also lets you view, accept, or 
join meetings in either app. 
 
To schedule a Teams meeting on Outlook, follow these steps: 

• Switch to the calendar view on Outlook. Click the New Teams Meeting tab. 

• Add individual participants or entire contact groups to the Required or Optional fields. 

• Type in the topic, start time, and end time of the meeting. There’s no need to add the dial-in phone 
numbers and conferencing IDs to the invite, as Outlook does this automatically for you. 

• Create a message inviting the recipients to the meeting, then click Send. 

 

5. Tag Your Outlook Contacts 
To get the attention of a specific person in a group email or meeting invite, use the @Mention function. 
This works particularly well for emails sent to multiple recipients or if you want to convey the urgency of 
your message. 
 
In the body of your email or invite message, type the @ symbol followed by the name of the person you 
want to tag (e.g., @johndoe). Doing so will highlight the name in the message and automatically add it to 
the To line of your message. You can also search for messages you’re tagged in by selecting Filter 
Email from the Home tab, and then clicking Mentioned. 
 

Microsoft Word Tips 
Get some more tips for streamlining your work in Word and connected Office apps: 
Time-saving Tips for Microsoft Word 
 

Get More Outlook Tips and More Office 365 Training from SWK 
These are just some of the things you can do to improve your experience in Outlook and the rest of your 
Office 365 suite. SWK can help you educate your staff and provide the best value on your Microsoft 
systems, including learning how to spot ransomware threats targeting Windows and other tips for Office 
apps. 
 
Contact SWK Technologies today to learn more about what Outlook and Office 365 can do for you. 

5 Tips for Working Smarter in Microsoft Outlook Shiny gadget of the month:  
Meural WiFi Photo Frame 

The digital photo frame, many of us have had one or 
still do have one. The concept is good, you have a 
frame that can show a single image or rotate through 
a slide show, but as technology has advanced the task 
of saving photos to these frames seems arduous. We 
are so used to having everything at our fingertips and 
being completely digital that using physical media to 
transfer photos is inconvenient. However, Meural is 
here to change that.  
 
The Meural WiFi Photo Frame is designed to be the 
perfect new accessory for your home or office. It has 
a large display that can adapt seamlessly to portrait or 
landscape depending on how it is positioned and will 
automatically adjust to the room’s brightness like a 
cell phone screen would. The best feature though is 
that it is a connected device so you can simply link 
your smartphone up with the frame to share photos 
for display. You can even create photo playlists and 
set them for different times of day too. 
 
If you have a family member who has a Meural like a 
grandparent, you can share photos directly with them 
on their Meural, so they can be instantly connected 
with your family. Family and friends can all easily be 
invited to a shared album so you can all share 
experiences too.  
 
Sharing your own photos isn’t the only thing this 
gadget can do. There is also a professional art 
collection of over 30,000 images that you can choose 
from to display. This does come at an annual fee, but 
is a really unique idea that certainly adds another 
dimension to the usefulness of the product.  
 
All in all, Meural takes the digital photo frame and 
updates it to modern standards. For those of us who 

are looking to add something new to our homes 
during this stay at home period in our lives this could 

be perfect. While the price is a little steep, coming in 
at $299.95, it could really be a nice way to keep 

things fresh for your home office. The ability to 
create playlists for different times of day would 
always give you something new to look at. It will be 

interesting to see if this concept of an updated digital 
photo frame will catch on. Check it out for yourself 

here: https://meural.netgear.com/photo-frame/.  
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Contact us 
Give us a call for more information 
about our services and products.  
 

SWK Technologies, Inc. 
South Jersey 
650 Grove Road, Suite 106 
West Deptford, NJ 08066 
 

North Jersey 
120 Eagle Rock Ave., Suite 330   
East Hanover, NJ 07936 
 
Phone: 856.956.5800 
Fax: 856.845.6466 
 
Visit us on the web at 
www.swknetworkservices.com 

We can help you with: 

• Cybersecurity 

• IaaS 

• Complete network management and support 

• Troubleshooting and problem solving on all PCs and Macs 

• Cloud services and virtualization 

• Hardware installation and support 

• Virus / spyware removal and  
      protection 

• Security solutions 

• Employee awareness training 

• VPN (Virtual Private Networks) 

• Remote access / Mobile computing 

• Server installations and upgrades 

• Spam filtering  

• Hosted email 

• Web content filtering 

• System backups, on-site and off-site 

• Help desk 
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Many businesses have been severely affected by the COVID-19 pandemic, but investing in cloud hosting technology has allowed several organizations to ensure seamless 
business continuity. The coronavirus shutdowns have generated persistent disruptions across global supply chains and forced new demands for business resilience and survival. 
Offsite server resources and digital IT infrastructures provided as a service provide unprecedented opportunities to improve ROI on technology spending and maintenance.  
 
Here are the biggest ways hosting your technology stack in the cloud will help your business survive COVID-19: 

Ensuring Business Continuity and Resilience with Cloud Hosting 
The need to stay at home and practice social distancing have changed the way many businesses operate. With their employees unable to come to the office, organizations are 
forced to function with a remote team whose members are often miles away from each other. 
 
This is where cloud technology helps. When you migrate your data to the cloud, your files are stored in a centralized server that can be accessed via the Internet. So as long as a 
user has an Internet-connected device (like a smartphone or laptop) and has the right login credentials, they can access these files from any location. The cloud also allows 
multiple users to work on a single file at the same time. Any change to the file is seen in real-time, which makes it feel like team members are collaborating in the same room. 
 
The beauty of cloud technology is that it is scalable to your needs, demands, and preferences, and can be deployed flexibly through multiple models. SaaS (Software as a 
Service) delivers your system completely digitally like a web browser, while IaaS (Infrastructure as a Service) hosts your network resources remotely but provides onsite control 
of data. Hybrid options are also available that let you combine existing on-premise and remote servers. 
 
Moreover, with cloud-based communication tools like Microsoft Teams and Slack, your team can communicate with each other through chat, voice calls, and video 
conferencing. By incorporating these technologies into your processes, your organization can function efficiently while following social distancing protocols. 
 

Saving Money with SaaS and IaaS 
Instead of buying hardware with company funds and issuing these machines to your staff, you can have them use their personal laptop computers and mobile devices instead. 
With this tactic, however, you’re not sure if your employees’ devices have the appropriate specifications to handle their workload. 
 
If you use special software, you may also have to buy and install them on your staff’s personal devices. In short, whether you issue computers or adopt a bring your own device 
approach, you’re bound to spend a lot of money to facilitate remote work. 
 
But with cloud computing, you won’t need to buy new hardware. You can host your applications on the cloud, enabling a user to run them through a web browser even if they 
are not installed in his or her device. And because hosted applications use the cloud provider’s resources, they don’t strain user’s devices and can be used even with older or 
lower-end computers. 
 
Furthermore, hosting applications on the cloud eliminates the need to install programs in each of your staff’s devices. This is particularly helpful if the software you use has a 
limit on the number of devices it can be installed on. This way, you save money by not having to invest in newer devices for your staff and wasting time locally downloading the 
software. 
 

Cybersecurity for Hosted Software 
Cybersecurity is a concern for both on-premise and cloud-hosted servers, but the latter allows providers to offer real-time security monitoring and endpoint protection. 
Traditional setups only allow you to work from home with legacy remote access to your business data, and these connections can be notoriously unsecure. Working with a cloud 
service provider (CSP) that offers around the clock network security and managed IT services for your hosted environment will ensure on demand support. 
 
Should You Migrate to the Cloud Now? 
The short answer is yes. Thanks to the COVID-19 lockdowns, the ability to work remotely has now become essential to a business’s survival and the cloud easily facilitates a 
remote work environment. However, SWK Managed Cloud Services can help you move at your own pace, keeping your data integrity intact and your systems secure without 
breaking the bank. 
 
Sign up here to see how migrating to the cloud with SWK will provide you the best value on your software investment. 

How Cloud Hosting Helps Businesses Survive COVID-19 Disruption 
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